Authoring Connexions Modules using Microsoft Word Documents

By:
Kenneth Leroy Busbee
Authoring Connexions Modules using Microsoft Word Documents

By:
Kenneth Leroy Busbee

Online:
< http://cnx.org/content/col11154/1.4/ >

CONNEXIONS
Rice University, Houston, Texas
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Preparation Before the Connexions Authoring Workshop</td>
<td>1</td>
</tr>
<tr>
<td>2 Why You should Create a Personal Connexions Account</td>
<td>5</td>
</tr>
<tr>
<td>3 Creating a Connexions Account</td>
<td>9</td>
</tr>
<tr>
<td>4 Creating Workgroups within Connexions</td>
<td>13</td>
</tr>
<tr>
<td>5 Preparing a Word Document for Creating a Connexions Module</td>
<td>15</td>
</tr>
<tr>
<td>6 Creating a Connexions Module from a Word Document</td>
<td>23</td>
</tr>
<tr>
<td>7 An Example of a Connexions Module Created by a Word Document</td>
<td>35</td>
</tr>
<tr>
<td>8 Creating a Connexions Collection</td>
<td>39</td>
</tr>
<tr>
<td>9 Post Connexions Authoring Workshop Activities</td>
<td>51</td>
</tr>
<tr>
<td>Glossary</td>
<td>54</td>
</tr>
<tr>
<td>Index</td>
<td>55</td>
</tr>
<tr>
<td>Attributions</td>
<td>56</td>
</tr>
</tbody>
</table>
Chapter 1

Preparation Before the Connexions Authoring Workshop

1.1 Preface

The modules in this collection are designed for either self-study or as a major part of a 4 hour in-person workshop. They are designed specifically to guide new authors in the process of creating several modules and then organizing them into a collection. Existing materials within the Connexions website often explain authoring in a more technical manner than what most new authors desire. Thus, a less technical and more user friendly step-by-step instructions/training is needed to guide a new author using Connexions. Many new authors will have limited technical computer training; however, they should be able to create fantastic OER materials using the convenience of uploading a Microsoft Word document to create a basic Connexions module.

1.2 Learning Objectives

This workshop will specifically accomplish the task of helping you become a Connexions author by using Microsoft Word documents as the fundamental building and editing method for creating Connexions modules. During the workshop you will:

1. Open a Connexions account
2. Build an author profile
3. Prepare a Microsoft Word document for conversion into a Connexions module
4. Create a Connexions module
5. Understand how modules will affect the creation of a Connexions collection

1.3 Prerequisite Knowledge – General Reading

A prerequisite link (box in the upper right corner if viewing this on the Internet) is provided to “Introduction to Open Educational Resources” collection number “coll10413” within the Connexions website. The material written by Judy Baker is an excellent review of many issues of concern to new authors. If you are completely unfamiliar to the Open Educational Resources (OER) or OpenCourseWare (OCW) movement within the educational community; you should spend an adequate amount of time (usually several hours) learning this material. If moderately familiar, you should spend about 1 hour quickly covering the material. You can return and review the material in more detail as needed.

1 This content is available online at <http://cnx.org/content/m33244/1.6/>. Available for free at Connexions <http://cnx.org/content/coll11154/1.4>
The third module should be specifically viewed. It’s title: OER Fair Use, Copyright, and TEACH Act. A basic understanding of copyright, fair use, the TEACH Act, and intellectual property is necessary before using and developing OER in order to minimize the risk of violating the law. Many college professors step over the line and violate the copyrights of authors. As you are embarking on your own journey as an author, please make sure that you understand how to include existing materials without violating another author’s copyright.

This prerequisite material may be covered in a training course available to you at your institution. If so, you should consider taking that course before embarking on the path to becoming an OER author.

1.4 Knowledge Chunks

The concept of a “knowledge chunk” is to divide learning materials into small units that cover or focus on a single topic. The following two items help explain this concept.

1.4.1 Learning Objects

*Learning objects are a new way of thinking about learning content. Traditionally, content comes in a several hour chunk. Learning objects are much smaller units of learning, typically ranging from 2 minutes to 15 minutes.*

*Are self-contained – each learning object can be taken independently*

*Are reusable – a single learning object may be used in multiple contexts for multiple purposes*

*Can be aggregated – learning objects can be grouped into larger collections of content, including traditional course structures*

*Are tagged with metadata – every learning object has descriptive information allowing it to be easily found by a search*.

1.4.2 What is a Module?

A module is the basic building block of a Connexions course, textbook, or other type of collection. You can think of it as a small knowledge chunk that addresses a single topic or a specific aspect of a topic. Every author determines the size of their module, ranging from a few paragraphs to an entire textbook chapter. To a student or reader viewing a course or collection, a module is simply a web page in the collection. Modules allow readers to follow the information path arranged by the author or instructor or to branch off and discover their own path. To an instructor putting a collection together, having topics in different modules allows easy selection and arrangement of the information. An instructor can include existing modules from other courses or other academic disciplines that are important to the presentation of the course subject.

---


<http://cnx.org/content/m14465/1.3/>.


<http://cnx.org/content/m10887/2.28/>.

Available for free at Connexions <http://cnx.org/content/col11151/1.4>
1.5 Content Preparation before the Workshop

1.5.1 Module Content

You need to prepare some subject matter content before you try to create a Connexions module. We suggest that you create two or three small knowledge chunks where each one addresses a single topic. Don’t worry about how they will be transformed into Connexions modules. There are two word processing don’ts:

- Do not use `cntl_Enter` as a break. They don’t import into Connexions.
- Do not use tabs. They also do not import into Connexions.

Additionally, for each knowledge chunk that will become a module create:

- a title line
- a one or two sentence summary

I find it easiest to use an Excel spreadsheet for keeping track of modules that I am creating. It allows me to prepare the titles for the modules and their summary information as I prepare the knowledge chunks. The titles and summaries can then be easily copied and pasted as needed when building the modules within Connexions.

![Excel Spreadsheet](http://cnx.org/content/col11154/1.4)

**Figure 1.1:** Spreadsheet example for creating titles and summaries.

Available for free at Connexions <http://cnx.org/content/col11154/1.4>
CHAPTER 1. PREPARATION BEFORE THE CONNEXIONS AUTHORING WORKSHOP

It is important that you do this before any in-person workshop. During a workshop you will not have time to create or organize your content into knowledge chunks.

1.5.2 Picture

Using your picture processing skills; modify a picture of yourself cropping it square. It should be no greater than 150 by 150 pixels on each side. Usually this file is stored in a .jpg format.

NOTE: The Connexions web site will shrink your picture to fit its allocated space; thus, to avoid distortion, you should make sure to crop the picture square.

1.5.3 Short Biographical Sketch

Prepare a short biography about yourself. Information should include your current job, past employment, educational and professional attainments, etc.

1.5.4 Example

A link is provided (in the box at the upper right corner of this module’s page) to my “Member Profile” (for Kenneth Leroy Busbee) at Connexions. You will be using your picture and biography to create your “Member Profile” when you create your Connexions account. Again, during an in-person workshop you will not have time to prepare these materials, thus: please do them ahead of time.

Remember to bring these electronic files with you (usually on a flash drive) to any in-person workshop.
Chapter 2

Why You should Create a Personal Connexions Account

2.1 Several Good Reasons

With a Connexions account you can:

- Provide feedback to authors and other users by rating modules – This feedback from all users (other authors, students using textbook collections, etc.) helps authors decide which modules need improving and helps other users in evaluating the quality of repository content.
- Have your own “My Favorites” lens and make other “Member List” lenses
  - Save your place when reading through a collection is a feature of the “My Favorites” lens
  - You can make your own private “Member List” lenses to create the ability for you to focus on part of the repository
- Improve the quality of instructional materials and scholarly works available to the world via the Internet – free 24/7
  - Contribute materials that you author to the Connexions repository
  - Remix or change (customize) materials provided by others that are in the Connexions repository
  - Build collections (a group of modules) that specifically serve your students or audience from modules that you either create, improve or use without changing

Often being an author, is over emphasized and pushed as the number one reason to get a Connexions account. Having authors contribute to the repository is important; however usage of the repository by users is equally important. Increasing quality content in the Connexions repository goes hand in hand with increased usage of that content. It’s like the Chinese “Yin & Yang”, both are important. We encourage all to create an personal account.

\[^{1}\text{This content is available online at } <\text{http://cnx.org/content/m33937/1.1/}>.\]
2.2 Available Training

A link is provided (in the box at the upper right corner of this module’s page) to the “Busbee’s Connexions Training” lens. It contains six collections that cover:

1. Understanding the Vision of Connexions
2. How to Search and Browse the Connexions Web Site (includes rating modules)
3. Effectively Using and Creating Connexions Lenses
4. Authoring Connexions Modules using Microsoft Word Documents
5. Ideas and Tools for Improving Connexions Modules and Collections
6. Appendix Materials for a Connexions Collection used as a College Course

Each collection consists of several modules. The items appear alphabetically within the lens; however the “Lens Comments” for each item has its item position number similar to the list above. The first four items provide a natural progression for training.

You might want to bookmark the URL to the lens in your browser. The link is: http://cnx.org/lenses/kbusbee/cnx-training²

2.3 Connexions Help

Don’t hesitate to use the “Help” tab on the connexions home page at: http://cnx.org/³

It is organized differently than the above training collections, but contains ample information on how to use the Connexions Project. Don’t be afraid to click on something. Some of the menu items on the left expand as you click on them.

²http://cnx.org/lenses/kbusbee/cnx-training
³http://cnx.org/
Figure 2.2: Connexions Help Tab

Available for free at Connexions <http://cnx.org/content/col11154/1.4>
Chapter 3

Creating a Connexions Account

3.1 Create an Account

From the Connexions home page at: http://cnx.org select the “Get an account” under Step 1. Follow the process as directed. When prompted for “Member Profile” information you should complete fields as appropriate. The following will help you to complete certain areas.

3.1.1 Affiliation – Institution

You should review how others are typing their “Affiliation” and type yours the same. For example: authors from Houston Community College could use: HCC or Houston CC or Houston Community College. However, they should all use: Houston Community College. This is not super important for the profile, but you will want to type the “Institution” field in a collection consistently so collections created by authors from the same institution will all show up together when users do an institution search. The following two slides show you how to browse to the “Institutions” search and review what authors from your institution are using for their affiliation/institution name.

---

1This content is available online at <http://cnx.org/content/m33888/1.1/>.
2http://cnx.org/
Browsing by: Title, author, etc.

Figure 3.1: Browsing

Available for free at Connexions <http://cnx.org/content/col11154/1.4>
3.1.2 Biography – Short Biographical Sketch

Prepare a short biography about yourself. Information should include your current job, past employment, educational and professional attainments, etc.

3.1.3 Portrait – Picture

Using your picture processing skills; modify a picture of yourself cropping it square. It should be no greater than 150 by 150 pixels on each side. Usually this file is stored in a .jpg format.

NOTE: The Connexions web site will shrink your picture to fit its allocated space; thus, to avoid distortion, you should make sure to crop the picture square.

3.1.4 Example

A link is provided (in the box at the upper right corner of this module’s page) to my “Member Profile” (for Kenneth Leroy Busbee) at Connexions.

Available for free at Connexions <http://cnx.org/content/col11154/1.4>
3.2 Editing your Member Profile

You can change your “Member Profile” at any time. This slide shows how to get to the page for changing it.

Figure 3.3: Editing an Member Profile

Once you have logged in, 1) click on MyCNX
2) click on
3) click on
Chapter 4

Creating Workgroups within Connexions

4.1 Personal Workspace

At first you will only have only a few modules and you can use your “Personal Workspace” for the storage location of your modules. However, as your numbers of modules grow, you will want to organize your modules into various projects or folders. The creation of workgroups allows you to organize your modules and collections.

4.2 Workgroups

You can see from the slide below that by clicking on “MyCNX” and selecting “Create a Workgroup” you are able to create areas by giving them a name and some general information. I have created several workgroups and the one highlighted in green is the workgroup for the modules and the collection associated with this workshop.

1This content is available online at <http://cnx.org/content/m33245/1.5/>.
CHAPTER 4. CREATING WORKGROUPS WITHIN CONNEXIONS

4.2.1 Simple Organization

Most new authors will create workgroups for simple organization of the modules and collections that they are working on. That is why I have four workgroups.

4.2.2 Shared Access for Collaborative Efforts

Another reason to create a workgroup is to allow shared access to other authors. Thus, several authors can work on a group of modules that is usually built into a collection. This is one of the collaborative benefits of the Connexions Project. The lead author will build a workgroup and share it with one or more authors. The co-authors can modify any modules or collections in the shared workgroup.

Additional information about sharing workgroups is in the link provided (in the box at the upper right corner of this module's page) for the “New Author Guide” within the “Authoring” section of the “Help” tab.

Available for free at Connexions (<http://cnx.org/content/col11154/1.4>)

Figure 4.1: Creating Workgroups

NOTE: You might want to keep the workgroup names relatively short. They will appear better in the menu of “SHARED WORKGROUPS.”
Chapter 5

Preparing a Word Document for Creating a Connexions Module

5.1 Existing Documentation and Approach

A link is provided in the box to the right for the Connexions web site materials prepared for “Using Microsoft Word to Create a Connexions Modules”. However, the materials are not organized in a fashion that guides a new author from the perspective of how to create a Word document in order to build a Connexions module. Additionally, some information about the use of “templates” applies to an older version of Word (Word 97 or Word 2003). It says that the importer supports the new Microsoft Word 2007 (which creates documents using the .docx file extension), but I have had problems with importing these files as Connexions modules.

This module will take the approach of showing which Word features are preserved (kept) during importing and how you can add Connexions CXML formatting styles to your Word document to import other useful effects. This will allow you to easily create fantastic OER materials using the convenience of uploading Word documents to create a basic Connexions module.

5.2 Typing Your Document Draft

For instructional purposes we have several versions of a Word document file showing its progression from initial typing to a finished product. The subject matter of the document is about flying. The first version shows raw typing that can be done quickly. The second version shows normal formatting that an author would do to a document. You should download the documents to see how they were created.

Click to download: Flying_Ver1.doc
Click to download: Flying_Ver2.doc

Many people will format their documents as they produce it. Thus, the two step approach will be done in only one document. These documents are in the .doc format which is the older Word 97-2003 format. I used the newer Micorsoft Word 2007 software that handles these documents in a “Compatibility Mode”. The following items are formatting effects that will be preserved (will convert) into your Connexions module. They are listed in the order in which they appear in the Flying_Ver2.doc file.

5.2.1 Preserved Effects

1. **Heading 1** – highlight the text and select “Heading 1” from the “Styles” box on the ribbon. As one example see the first line of the document.

1This content is available online at <http://cnx.org/content/m33255/1.3/>.
2See the file at <http://cnx.org/content/m33255/latest/Flying_Ver1.doc>
3See the file at <http://cnx.org/content/m33255/latest/Flying_Ver2.doc>

Available for free at Connexions <http://cnx.org/content/col11154/1.4>
2. **Heading 2** – highlight the text and select “Heading 2” from the “Styles” box on the ribbon. As one example see the second line of the document.

3. **Italic** – highlight the text and select “I” from the “Font” box on the ribbon. Look for the word jokes as the example.

4. **Bulleted List** – highlight the list and select the “Bulleted List” item from the “Paragraph” box on the ribbon.

5. **Bold** – highlight the text and select “B” from the “Font” box on the ribbon. Look for the word fictitious as the example.

6. **Numbered List** – highlight the list and select the “Numbered List” item from the “Paragraph” box on the ribbon.

7. **Table** – use the “Insert Tab” selecting “Table” from the “Tables” box on the ribbon.

8. **Hyperlink** – use the “Insert Tab” selecting “Hyperlink” from the “Tables” box on the ribbon.

9. **Picture** – use the “Insert Tab” selecting “Picture” from the “Illustrations” box on the ribbon. This picture was sized to 320x240 pixels in order to better fix the web page when converted into a Connexions module.

10. **Footnote** – use the “References Tab” selecting “Insert Footnote” from the “Footnotes” box on the ribbon.

### 5.2.2 Effects Not Preserved

Some items do not import that is that are not preserved during the conversion process to a Connexions module. These have been mentioned, but are provided again as a reminder:

- Do not use `cntl_Enter` as a break.
- Do not use tabs.

### 5.2.3 Showing the Existing Styles

The following slide shows the default formatting styles available in Word.

Available for free at Connexions <http://cnx.org/content/col11154/1.4>
In order to add special formatting styles created by Connexions, we will need to acquire a document that has these special tags. To get the file:

Click to download: Connexions-Document.doc\footnote{See the file at <http://cnx.org/content/m33255/latest/Connexions-Document.doc>}

After downloading, open the file and save it as (Save As): Flyer_Ver3.doc

By doing so, you will retain your original file intact for future use.

5.3 Converting Your Draft Document

The contents for the new Flyer_Ver3.doc file contain some basic text as provided by Connexions. This text is unimportant to us. Highlight the text and delete it.
5.3.1 Copy and Paste Your Draft Document

Now open your existing draft document: Flying_ver2.doc, select the entire document and copy it into the Flying_ver3.doc file. This new version of the document will have the Connexions CNXML formatting styles.
You are now ready to add some additional formatting to your document that adds tags to inform Connexions as how it should convert your document when imported it into Connexions as a module. An example of highlighting some text and tagging it as a “term” is shown in the following slide.
CHAPTER 5. PREPARING A WORD DOCUMENT FOR CREATING A CONNEXIONS MODULE

Figure 5.4: Applying a CNXML formatting style

The following list of CNXML tags are listed in the order in which they appear in the Flying_Ver3.doc file. You can download the document and review the tags.

Click to download: Flying_Ver3.doc

5.4.1 List of CNXML Formatting Styles

1. **CNXML Quote (Inline)** – If you have text as a quote you should remove your quote marks and highlight the text, then apply the style. The conversion automatically adds quote marks.

2. **CNXML Term** – Tagging a word as a term will highlight it upon conversion. IN our example we tagged “Hades”. When the module is included in a Connexions collection the term will automatically be added to the “Index of Keywords and Terms” at the end of the collection.

3. **CNXML Note** – Highlighting text and applying the tag will make the text appear in a separate note box upon conversion. Thus, you will need to remove the wording “Note: ” from your document.

4. **CNXML Figure Title** – You can add a line of text just before a picture, highlight that text and apply this tag to create a title above your picture.

5. **CNXML Figure Caption** - You can add a line of text just after a picture, highlight that text and apply this tag to create additional comments below your picture.

---

Available for free at Connexions <http://cnx.org/content/col11154/1.4>

See the file at <http://cnx.org/content/m33255/latest/Flying_Ver3.doc>
6. **CNXML Quote (Block)** – Highlight the text and apply the tag. No need to use quote marks, the conversion will indent and italicize the quote.

7. **CNXML Definition (Term)** – The term is usually placed on a line by itself with the definition on the following line(s). Like other formatting styles you highlight it and tag it. When the module is included in a Connexions collection the term will automatically be added to the “Index of Keywords and Terms” at the end of the collection.

8. **CNXML Definition (Meaning)** – The meaning of the term is added to the line(s) following the term. Like other formatting styles you highlight it and tag it. When the module is included in a Connexions collection the term with its definition will automatically be added to the “Glossary” at the end of the collection.

## 5.5 What’s Next?

### 5.5.1 Additional Information

Once you start creating Connexions modules, you will not go through the process of converting your draft document by copying it’s content and pasting it into a Connexions document shell that has the Connexions CNXML tags. You will simply open the original downloaded file that contains the tags (Connexions-Document.doc) and save it as a new document (you must keep it as a .doc file – that is the older Word 97-2003 format). Highlight and delete the existing sample text. Then start writing your module materials. As you build the document you can add any of the formatting styles (both those preserved from normal Word usage and those CNXML tags that will be available to you).

### 5.5.2 Authoring Workshop Application

You should spend a few minutes getting one of your prepared “knowledge chunks” ready for conversion into a Connexions module. At a minimum, use at least two of the preserved effects and at least two of the CNXML tags.
Chapter 6

Creating a Connexions Module from a Word Document

6.1 Initial Creation of a Module

The following series of slides moves you through the process of creating a Connexions module.

\[^{1}\text{This content is available online at <http://cnx.org/content/m33262/1.2/>.}\]

Available for free at Connexions <http://cnx.org/content/col11154/1.4>
6.1.1 Step 1

![Image of Navigate to Your Workgroup]

**Figure 6.1: Navigating to Your Workgroup**

6.1.2 Step 2

When the “New module: License agreement” screen appears, read the information, check the box that you agree and move on to “Next”.

Available for free at Connexions <http://cnx.org/content/col11154/1.4>
6.1.3 Step 3

**Figure 6.2:** Establish the new module’s “Metadata”

There are five (5) items within the metadata. Two of them will be established by copying and pasting the “Title” and “Summary” from your previously prepared spreadsheet (see the next slide). Most authors using these materials will leave the “Language” selection as English. Check one of the six (6) “Subject” boxes most appropriate to your module content.

The “Keywords” box allows you to enter additional words (one concept per line) that will be added to the “Index of Keywords and Terms” that would be automatically created when this module is included in a collection. Don’t add items that have already been tagged within the document as “CNXML Term” or “CNXML Definition (Term)”. In the example above the keyword “Butterfly” was added to this module. Click on “Next” when ready.

Available for free at Connexions <http://cnx.org/content/col11154/1.4>
CHAPTER 6. CREATING A CONNEXIONS MODULE FROM A WORD DOCUMENT

Transferring the Title and Summary

Figure 6.3: Transferring the Title and Summary

Available for free at Connexions <http://cnx.org/content/col11154/1.4>
6.1.4 Step 4

A work area with seven (7) tabs will appear with the “Edit” tab active. The “Edit” tab allows you to build the module content. However, we are not going to type in our module content, but import it from a Microsoft Word document (previously prepared). Click on the “Import” button.

Available for free at Connexions <http://cnx.org/content/col11154/1.4>
6.1.5 Step 5

Figure 6.5: Browsing to Your File

Follow the steps to browse to your previously prepared Word document; then "Import" it.
6.1.6 Step 6

Links

We have basically completed the “Edit” and “Metadata” tabs. As a new author you will not normally use the “Files” or “Roles” tabs; thus we will not cover them within this training. Click on the “Links” tab.

Links are added to web pages but not to the printed .PDF files. They appear in the upper right part of a module’s web page. You have seen and used links in other modules associated with this training. There are four items to establish with a link:

- **Title** – this is the name that will appear in the links box
- **Type** – you select from Example, Prerequisite or Supplemental
- **Strength** – you select from 3 being strongly related, 2 being related and 1 being weakly related
- **Source** - can either be another Connexions module or collection (just enter its ID) or a Uniform Resource Locator (URL) better know as a web address. You might want to open another copy of your browser, navigate to the address, then copy and paste it into the URL box. This insures accuracy.

Click on the “Add” button when ready.

You may add additional links as desired.

Available for free at Connexions <http://cnx.org/content/col11154/1.4>
6.1.7 Step 7

The Preview allows us to view how our module will appear in both online and print modes. The online button will cause the module to appear as it will be shown. You can review it and test any links that you created. Hit the back button on your internet browser to return to the page and/or to return back to the Connexions module building page.

**NOTE:** If there is something wrong with the module content, you should open your original Word document make corrections, and then close it. Select the “Edit” tab and import your corrected file. Return to the “Preview” and confirm that the changes are what you wanted.

Available for free at Connexions (<http://cnx.org/content/col11154/1.4>)
6.1.8 Step 8

The publish process identifies a short description of the changes (enter “Initial Module” when you first create a module). When you hit the “Publish” button, the software will ask you to confirm “Yes” for you to publish your module.

Available for free at Connexions <http://cnx.org/content/col11154/1.4>
CHAPTER 6. CREATING A CONNEXIONS MODULE FROM A WORD DOCUMENT

6.1.9 Step 9

Figure 6.9: Module Completed and Built

Congratulations! Your module is now available for the world to use. I usually enter the module’s ID number into my spreadsheet that contains my titles and summaries.

6.2 Making Module Corrections

Once you have published your module, you will discover that you want to make some corrections or changes to your module. The process is simple. Navigate to your module.

Available for free at Connexions (<http://cnx.org/content/col11154/1.4>)
Figure 6.10: Navigate to Your Module
CHAPTER 6. CREATING A CONNEXIONS MODULE FROM A WORD DOCUMENT

In order to modify the module, you must “Checkout” the module first. This makes a copy of your module available for you to modify. While you are modifying your materials, the previous version of the module is available to the Internet community. Your module will appear with the seven (7) construction tabs. You make changes as needed (this may include editing your Word document and importing it again using the “Edit” tab). When you are done with your changes you need to “Publish” your module in order to make the changes available to the Internet community.

6.3 What’s Next?

6.3.1 Reviewing the Published Module

The next module within this workshop contains the results of creating the Flying_Ver3.doc document as a Connexions module. You should review it to aid in your understanding of how the features and styles that we inserted into a Word document were converted upon being imported to a Connexions module.

6.3.2 Authoring Workshop Application

You should spend a few minutes publishing one of your previously prepared Word documents as a Connexions module.
Chapter 7

An Example of a Connexions Module
Created by a Word Document

7.1 Flying

7.1.1 Historical View of Flying
For centuries man has looked to the sky and with awe wondered what it would be like to fly. We even have some jokes about flying that include other animals. “When pigs fly!” is old expression related to the temperature in Hades getting cold. The implication is that it will never happen.

NOTE: The Wright brothers were the first humans to fly on December 17, 1903.

Since then many methods of humans flying have occurred. Some are:

- Planes
- Helicopters
- Rockets
- Hang Gliders

7.1.2 Things that Fly
Many things fly and the top five as recorded in our fictitious poll include:

1. Birds
2. Planes
3. Insects
4. Superman
5. Flags

7.2 Impact of Flight on Pets

7.2.1 The People’s Choices
Many people maintain pets and the following table shows the place of birds on the current pet list.

---

1This content is available online at <http://cnx.org/content/m33252/1.4/>.

Available for free at Connexions <http://cnx.org/content/col11154/1.4>
CHAPTER 7. AN EXAMPLE OF A CONNEXTIONS MODULE CREATED BY A WORD DOCUMENT

<table>
<thead>
<tr>
<th>Category</th>
<th>Percent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dogs</td>
<td>42%</td>
</tr>
<tr>
<td>Cats</td>
<td>23%</td>
</tr>
<tr>
<td>Birds</td>
<td>14%</td>
</tr>
<tr>
<td>Turtles</td>
<td>4%</td>
</tr>
<tr>
<td>Others</td>
<td>17%</td>
</tr>
</tbody>
</table>

Table 7.1

7.2.2 Unique Pet Collections

My unique flying pet is a butterfly.

Here is a hyperlink: http://en.wikipedia.org/wiki/Butterfly

\(^2\)http://en.wikipedia.org/wiki/Butterfly

Available for free at Connexions <http://cnx.org/content/col11154/1.4>
A butterfly’s thoughts:

One cannot entirely trust to flowers that grow in pots,” thought the butterfly, "they have too much intercourse with men." I have added some more text to this quote to show how a block quote tag will wrap, indent and italicize the quoted material. Thus, you should not need any quote marks for the block tags.

**Definition 7.1: Crazy**
People who keep butterflies as pets and talk to them.

---

3Andersen, Hans Christian; The Ice-Maiden: and Other Tales, pg 169.

Available for free at Connexions <http://cnx.org/content/col11151/1.4>
Chapter 8

Creating a Connexions Collection

8.1 Initial Creation of a Collection

The following series of slides moves you through the process of creating a Connexions module.

This content is available online at <http://cnx.org/content/m33265/1.2/>.

Available for free at Connexions <http://cnx.org/content/col11154/1.4>
8.1.1 Step 1

Figure 8.1: Navigating to Your Workgroup

8.1.2 Step 2

When the “New collection: License agreement” screen appears, read the information, check the box that you agree and move on to “Next”.

8.1.3 Step 3

The next window established the “metadata” for the collection and you will copy and paste the title and summary information similar to the way you create a module. Complete the language, collection sub-type and subject items as appropriate.

NOTE: The first line of the spreadsheet contains the collection title and collection summary.

Available for free at Connexions <http://cnx.org/content/col11154/1.4>
Figure 8.2: Organizing Spreadsheet
8.1.4 Step 4

A work area with six (6) tabs will appear with the “Metadata” tab active. You need to at least scroll down and add one additional item to the metadata.
The “Institution” information should be typed consistently by all authors belonging to the same institution. This item was discussed earlier in the module covering the member profile. Enter your institution’s name and click on the “Save” button.
8.1.5 Step 5

Once the Metadata changes are saved, select the “Contents” construction tab.

We need to identify or associate our modules to the collection. This is easily done by searching for our modules. The module numbers should be on your organizing spreadsheet. Simply enter the module ID number and select the “Search” button.
8.1.6 Step 6

Figure 8.6: Verify Module Name – Add selected content

Simply verify that you have the correct module. Look at its name and author. If correct, click on the “Add selected content” button.
8.1.7 Step 7

Add the remaining modules from your organizing spreadsheet.

8.1.8 Step 7

Most new authors will not change the default data within the “Roles” or “Parameters”. Move on to the “Preview” tab. The collection will appear. You can review it and navigate with the collection to your heart’s content. However, when done, hit the back button on your internet browser to return to the page and/or to return back to the Connexions collection building page.

**NOTE:** If there is something wrong with the modules associated with the collection, you should return to the “Contents” tab and fix the problem by deleting or adding the correct modules. Return to the “Preview” and confirm that the changes are what you wanted.

Available for free at Connexions <http://cnx.org/content/col11154/1.4>
8.1.9 Step 8
The publish process identifies a short description of the changes (enter “Initial Collection” when you first create the collection). When you hit the “Publish” button, the software will ask you to confirm “Yes” for you to publish your collection.

8.1.10 Step 9

![Completed and Built](image)

**Figure 8.8:** Module Completed and Built

Congratulations! Your collection is now available for the world to use. I usually enter the collection’s ID number into my spreadsheet that contains my titles and summaries.

8.2 Making Corrections to a Collection

Once you have published your collection, you will discover that you want to make some corrections or changes to your modules. Additionally, you might want to add or delete a module within the collection. The process is similar to making corrections to a module. You must navigate to your collection and check it out.

Available for free at Connexions [http://cnx.org/content/col11154/1.4]
Your collection will appear with the six (6) construction tabs. You make changes as needed. When you are done with your changes you need to “Publish” your collection in order to make the changes available to the Internet community.

You should plan your changes to a collection. As you update individual modules, those corrected re-published modules are automatically available on the web version of your collection. The Internet version simply points to the “latest” version of a module.

As you make changes to a collection (add new modules, delete modules, etc.) you will need to re-publish the collection before the Internet users get a new collection’s .PDF file. The newly published collection will include a revised “Glossary” and “Index of Keywords and Terms” (see the next item on reviewing a published collection).

8.3 What’s Next?

8.3.1 Reviewing the Published Collection

The printed .PDF file for the collection will have a “Glossary” and “Index of Keywords and Terms” that was automatically produced from the modules included in the collection. Navigate to this workshop’s collection and download the .PDF file.
Open the downloaded file and scroll down towards the end of the collection and review the “Glossary” and “Index of Keywords and Terms”. They should contain the few items that were tagged within the Flying_Ver3.doc document and the keyword that was added to that module’s metadata when it was created.

Authors wanting a glossary and index should now understand how to add the correct tags and keywords when building their modules. Then when they group their modules into a collection they will get the intended results within the glossary and index which is automatically produced.

8.3.2 Authoring Workshop Application

You will not have time to create a collection during an in-person workshop. However, you should understand the process and how tags for terms and metadata keywords will appear in your materials.

Available for free at Connexions <http://cnx.org/content/col11154/1.4>
Chapter 9

Post Connexions Authoring Workshop Activities

9.1 Post Authoring Workshop Activities

9.1.1 Build Modules and Collections

Some authors will only build a few unrelated modules and never attempt to build a collection (a group of modules organized and delivered as a unit). Others will plan a complete textbook with dozens of modules organized into chapters. But all should:

- Spend a few hours over the next few weeks and building at least four (4) modules.
- Consider building a simple collection.

You might start the process by planning your modules by outlining them. You can use the spreadsheet method used earlier in this workshop to establish your module titles and summaries. Whatever you do, do something each week. Plan a few hours to work on becoming a Connexions author.

9.1.2 Provide Feedback

Anyone can email the author of Connexions materials and provide feedback. As a new author, you should not take offense if someone emails you and describes a problem with your content, spelling, broken links, etc. Take it in stride and use the feedback to improve your materials.

9.1.3 Ask for Feedback

As a new author you might want to contact a peer within your field of expertise and ask them to review your materials. Another pair of trusted eyes is great at insuring that your Connexions modules are viewed by others as quality modules.

9.1.4 Provide Module Ratings

When you are logged into your Connexions account, you can use the five (5) star rating system provided within Connexions to rate the modules of any authors.

1This content is available online at <http://cnx.org/content/m33264/1.3/>.

Available for free at Connexions <http://cnx.org/content/col11154/1.4>
CHAPTER 9. POST CONNEXIONS AUTHORIZING WORKSHOP ACTIVITIES

As your first experience at rating modules, we desire you to rate each of the seven (7) modules that were used in this workshop. **Please go do it soon — maybe even today.**

### 9.1.5 Affiliation Lens

An “affiliation lens” within Connexions is a way to identify modules and collections identified as having the author’s material affiliated with that organization, group or project. You can select the “Lenses” tab from the Connexions home page to view the lenses that exist.

You should scroll down the “Affiliation lenses” category and discover if your institution has an affiliation lens. If it does have a lens, you should **contact the person at your institution that manages the lens** and inform them of the collections and/or independent modules (those not in a collection) by providing them the collection ID numbers (like: col10621) and module ID numbers (like: m19171). They can easily add your collections and modules to the lens.

### 9.1.6 Additional Study

Within the link box (upper right corner of the module) there are several links provided.

- **Example Links** in this grouping provide access to several existing collections or modules. You can review them for ideas of how others are using and organizing Connexions materials.

Available for free at Connexions <http://cnx.org/content/col11154/1.4>
• Supplemental – Links in the grouping provide access to a variety of helps, modules and collections that cover being an author within Connexions.

**NOTE:** Within the workshop we covered 8 CNXML tags. In the link “Using Microsoft Word to Create Connexions Modules” there are an additional 9 CNXML tags that are covered.

### 9.1.7 Join the Movement

If your organization has a discussion list or blog concerning Open Educational Resources (OER) or Open-CourseWare (OCW), please join in those activities.

### 9.2 Authoring Workshop Application

- Ask any questions
- Rate the workshop modules
Glossary

C  Crazy  People who keep butterflies as pets and talk to them.
Index of Keywords and Terms

Keywords are listed by the section with that keyword (page numbers are in parentheses). Keywords do not necessarily appear in the text of the page. They are merely associated with that section. Ex. apples, § 1.1 (1) Terms are referenced by the page they appear on. Ex. apples, 1

B Butterfly, § 7(35)
C Crazy, 37
H Hades, 35
Attributions

Collection: Authoring Connexions Modules using Microsoft Word Documents
Edited by: Kenneth Leroy Busbee
URL: http://cnx.org/content/col11154/1.4/
License: http://creativecommons.org/licenses/by/3.0/

Module: "Preparation Before the Connexions Authoring Workshop"
By: Kenneth Leroy Busbee
URL: http://cnx.org/content/m33244/1.6/
Pages: 1-4
Copyright: Kenneth Leroy Busbee
License: http://creativecommons.org/licenses/by/3.0/

Module: "Why You should Create a Personal Connexions Account"
By: Kenneth Leroy Busbee
URL: http://cnx.org/content/m33937/1.1/
Pages: 5-7
Copyright: Kenneth Leroy Busbee
License: http://creativecommons.org/licenses/by/3.0/

Module: "Creating a Connexions Account"
By: Kenneth Leroy Busbee
URL: http://cnx.org/content/m33888/1.1/
Pages: 9-12
Copyright: Kenneth Leroy Busbee
License: http://creativecommons.org/licenses/by/3.0/

Module: "Creating Workgroups within Connexions"
By: Kenneth Leroy Busbee
URL: http://cnx.org/content/m33245/1.5/
Pages: 13-14
Copyright: Kenneth Leroy Busbee
License: http://creativecommons.org/licenses/by/3.0/

Module: "Preparing a Word Document for Creating a Connexions Module"
By: Kenneth Leroy Busbee
URL: http://cnx.org/content/m33255/1.3/
Pages: 15-21
Copyright: Kenneth Leroy Busbee
License: http://creativecommons.org/licenses/by/3.0/

Module: "Creating a Connexions Module from a Word Document"
By: Kenneth Leroy Busbee
URL: http://cnx.org/content/m33262/1.2/
Pages: 23-34
Copyright: Kenneth Leroy Busbee
License: http://creativecommons.org/licenses/by/3.0/
Module: "An Example of a Connexions Module Created by a Word Document"
By: Kenneth Leroy Busbee
URL: http://cnx.org/content/m33252/1.4/
Pages: 35-37
Copyright: Kenneth Leroy Busbee
License: http://creativecommons.org/licenses/by/3.0/

Module: "Creating a Connexions Collection"
By: Kenneth Leroy Busbee
URL: http://cnx.org/content/m33265/1.2/
Pages: 39-49
Copyright: Kenneth Leroy Busbee
License: http://creativecommons.org/licenses/by/3.0/

Module: "Post Connexions Authoring Workshop Activities"
By: Kenneth Leroy Busbee
URL: http://cnx.org/content/m33264/1.3/
Pages: 51-53
Copyright: Kenneth Leroy Busbee
License: http://creativecommons.org/licenses/by/3.0/
Authoring Connexions Modules using Microsoft Word Documents
A collection of modules designed for either self-study or as a major part of a 4 hour in-person workshop. Emphasis is on using Microsoft Word documents as the fundamental building and editing method for creating Connexions modules that lead to the creation of high quality Open Educational Resources (OER) materials. The creation of a Connexions collection with the potential use as an OpenCourseWare (OCW) textbook is explored.

About Connexions
Since 1999, Connexions has been pioneering a global system where anyone can create course materials and make them fully accessible and easily reusable free of charge. We are a Web-based authoring, teaching and learning environment open to anyone interested in education, including students, teachers, professors and lifelong learners. We connect ideas and facilitate educational communities.

Connexions’s modular, interactive courses are in use worldwide by universities, community colleges, K-12 schools, distance learners, and lifelong learners. Connexions materials are in many languages, including English, Spanish, Chinese, Japanese, Italian, Vietnamese, French, Portuguese, and Thai. Connexions is part of an exciting new information distribution system that allows for Print on Demand Books. Connexions has partnered with innovative on-demand publisher QOOP to accelerate the delivery of printed course materials and textbooks into classrooms worldwide at lower prices than traditional academic publishers.